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[bookmark: _Toc123998895]PREFACE

The purpose of this guideline is to:
· introduce the Gathering Information via Recreational and Technical (GIRT) Scientific Divers citizen science project; 
· give a brief background on GIRT’s development and organisational structure;
· outline GIRT’s adult teaching focus;
· describe how to adopt-a-wreck through the GIRT website;
· describe the core GIRT rapid survey and the four additional survey options that comprise a complete GIRT survey;
· outline how to post-process and submit survey data;
· outline how to estimate threat to your adopted site;
· list each data field and give the associated explanatory metadata; and
· explain how to do 3D photogrammetry of your site or features and to display that on the GIRT Sketchfab page (https://sketchfab.com/GIRT). 

1 [bookmark: _Toc123998896]INTRODUCTION

The destruction of underwater cultural heritage (UCH) has increased rapidly in the last two hundred years mainly driven by direct and indirect impacts from people. However, with climate change and increasingly violent storm events, a site’s equilibrium with its physical environment is under potentially greater or new threats from natural events.

Gathering Information via Recreational and Technical (GIRT) Scientific Divers is a conservation focused no-impact citizen-science project. It aims to train members to systematically document observable physical and natural features of historic shipwrecks, submerged aircraft and other submerged underwater cultural heritage (hereafter referred to as UCH) to facilitate the site’s ongoing protection and management. The focus of the GIRT citizen science project is to both encourage interested people to have an active and positive public archaeology role and to enable better understanding of the condition of UCH and the factors driving its preservation or deterioration. This guideline outlines the method for monitoring submerged sites. 

Through your voluntary participation in GIRT, you can assist others, to more easily see the condition or threats to our UCH, and to your adopted site in particular, and if there are patterns to events occurring in the marine environment that may impact other nearby sites. Through these methods GIRT members can contribute directly to science-based decision making and potentially the prioritisation of activities by relevant authorities or appropriately qualified community groups to protect or undertake rescue archaeology of submerged sites. GIRT members can also contribute to increasing the public’s understanding about real environmental changes or human activity affecting underwater cultural heritage in their waters.

GIRT members (individuals, groups and businesses) ‘adopt-a-site’ that is of interest to them and agree to monitor the site periodically using the GIRT survey methodology. 
Starting in the first year of observations, GIRT members are asked to identify potential or known threats to their site, and to estimate the likelihood and consequence of those threats. Based on this data, and sometimes following moderation discussions with the GIRT instructor, members allocate a ‘traffic light’ indication of threat to their adopted site’s preservation (Green, Yellow, Orange, Red). GIRT member’s indications of threat are shown on the publicly viewable adopted sites map as their site’s location icon. This can be viewed at https://www.girtsd.org/wrecks.

All survey records entered by members through the Survey Reporting tab in the internal members pages of the website are:

· linked to the names of the GIRT members who undertook the survey and their adopted site; and
· available as a downloadable PDF for GIRT members personal records.

An important element of GIRT is to encourage communication and information sharing between GIRT members and persons responsible for managing such heritage in the relevant jurisdictional waters. As GIRT members are able to download a PDF version of their submitted data, each GIRT member can choose to share their data with the relevant site manager for the purpose of the information becoming a part of the site’s condition record. In this way GIRT member contributions could go beyond this citizen science program and may have influence at a local, state or even national level. 

In order to collect data on a site, besides standard dive gear, members need:
· access to a camera with an underwater housing; 
· 30m fibreglass tape; 
· at least three photogrammetry scales; 
· one photography scale; 
· slate and pencil; and 
· relevant GIRT monitoring templates printed on waterproof paper.

Once data has been collected, GIRT members are encouraged to compare their results with other members, lead the analysis of aspects of research (i.e. site formation, marine life, correlation of storm data with observed sediment movements, modelling observed change to other proximal sites…..) or simply conduct further research on their adopted site, and present the results of their surveys or broader analysis of data to dive clubs or at conferences.

The latest version of this guidance document and survey sheets are able to be downloaded from the register to JOIN page on the GIRT website ( https://www.girtsd.org/register ).

[bookmark: _Toc123998897]2	GIRT SCIENTIFIC DIVERS PTY LTD 

GIRT Scientific Divers started in mid-2018 as part of PhD research at the University of New England, Armidale, Australia. GIRT’s development and administration were initially supported by the not-for-profit voluntary association Wreck Check Inc (Incorporation Number A42646). Following the completion of PhD studies in 2021, the GIRT Scientific Divers citizen science program administration was re-restructured. Since 4 April 2022, GIRT is solely administered under GIRT Scientific Divers PTY LTD (Australian Company Number 658 539 407). The Constitution of GIRT Scientific Divers PTY LTD only allows the company to pursue charitable purposes. As such, GIRT Scientific Divers is a not-for-profit citizen science program. GIRT is administered by a Board of Directors with day-to-day operations led by the Managing Director.

3 [bookmark: _Toc123998898]TEACHING GIRT

GIRT training was developed as an adult based learning programme. This is because GIRT is targeted at individuals over 18 years of age who have more than 50 logged dives. Adult learning (androgogy), as different to children focussed learn (pedagogy), recognises that adult learners bring their varied experience and are more self-directed and self-motivated. Adult learning also has a focus on hands-on learning (learn through play). 

Since 2018, GIRT has been taught in several ways to meet community interest to dive with a purpose and monitor underwater cultural heritage sites. Initially GIRT was only taught as a one-day face-to-face program. The GIRT one-day training sought to explain why members should participate, what would be the value of their contribution, and then how to apply the methodology. The choice of one-day teaching was initially driven by financial expediency and available time.

The one-day training program quickly evolved into a two-day training program, with the second day focused on using the GIRT method as a team. This was in recognition of the need to reinforce class-based learning with hands-on activities. 

In all training options, GIRT is taught as an activity broadly comprised of three parts:  

1. planning and preparing for a survey activity; 
2. doing the survey activity, and saving and labelling the data on the day; and 
3. post-processing the collected data and entering it as a report. 

The reason it is taught in this way is to emphasize the importance of each stage and to assist members to recognise that the survey is not finished until a survey report is submitted. 

During COVID, GIRT training was delivered online, with an adaption of the original one-day workshop delivered during two blocks of three hours over two days. It was recognised at the time that this was not the ideal for teaching GIRT however it was seen as an opportunity to offer something to the community during COVID, an opportunity to promote GIRT, raise broader awareness of the threats to underwater cultural heritage, and to identify people who wished to participate who could receive further support in the future.

These version 3 guidelines outline the new GIRT teaching program approach. This teaching approach recognises that many people trained to be GIRT members have not to date completed a survey report but are known to have done a survey. To hopefully remedy this issue, the new GIRT teaching program incorporates the two-day GIRT training model but re-structures the curriculum, so it is more achievable for members.  In the text below, a scaffolded learning approach is outlined, which aims to systematically build on a members’ experiences and knowledge so they can learn new skills more comfortably.  The new scaffolded learning program uses the original GIRT survey components however it breaks the learning down to a small core rapid survey component (GIRT rapid survey), that can be done underwater and followed with simple and quicker post processing of data for submitting a survey report. Up to four additional survey activities are then outlined. These additional survey activities can be undertaken to any scale and in any combination, subject to a members’ knowledge level, comfort, interest, the environmental conditions, diving safety parameters and commitment. 

4 [bookmark: _Toc123998899]ADOPTING A WRECK

To adopt a wreck in the GIRT website, a member can do this in one of two ways. The first way is to look to see if the vessel’s location is already in the database. To do this, simply log in to the member’s portion of the GIRT website and click on the TO ADOPT A WRECK Page (Figure 1)

[image: ]
Figure 1: Internal GIRT website tabs showing the To ADOPT A WRECK tab.

On this page members can search in the left-hand sidebar for their adopted wreck by name, wreck ID, other members name, physical location, year of recorded sinking or by whether the site has been adopted once or twice before (Figure 2).

[image: ]
Figure 2: shows a text based search for a vessel’s name.
	
Once the wreck is located, you only need to click on the site icon and in the pop-up box that appears, click on the adopt button (Figure 3).

[image: A screenshot of a map
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Figure 3: shows a pop-up box for a site with the ADOPT button highlighted.

If your wreck is not in the GIRT wreck database, simply provide the following information to girtscientificdiver@gmail.com and a site profile can be created in the GIRT wreck database: 
the latitude and longitude of your site in decimal degrees (you can get this from Google Earth);

· the name of the site;
· year the wreck sank; and 
· an image for the site (Figure 4 and 5). 

Once a record is made you will receive an email notifying you the record is made and then you can repeat searching for site outlined above and adopt the wreck as in Figure 1-3.

[image: ]
Figure 4: The right-hand side bar shows the fields used to create a new site to adopt in the GIRT wrecks database
[image: A screenshot of a computer
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Figure 5: Shows a site record that has been created and adopted by one member.

5 [bookmark: _Toc123998900]GIRT SURVEY 

As stated above, the GIRT Scientific Diver survey comprises the core GIRT rapid survey and up to four additional survey activities. 

The GIRT rapid survey is designed to be completed in one or two dives by a buddy pair and is less complex and time consuming both underwater and during data post-processing for members. This rapid survey comprises completing a site identification sheet, a site sketch sheet, and a photo condition sheet. Members joining GIRT, and who do not bring experience in collecting data, should first use the GIRT rapid survey method until they are comfortable with the in-water survey process, post-diving data management, post-survey data processing and submission of their survey report.

Once a member is comfortable with undertaking a GIRT rapid survey and can complete all aspects, members are then encouraged to choose to undertake one, some, or all of the four additional survey activities: a video-transect survey; photogrammetry of features/site; collecting additional site and conservation data; and or undertaking a marine-life survey. Survey sheets for the video-transect survey; photogrammetry survey and site and conservation data survey are available to be downloaded from the GIRT website at https://www.girtsd.org/register.  Any data collected by a member for a marine-life survey simply needs to be saved as a PDF to be included in the final site SURVEY REPORT. 

To undertake a complete GIRT survey, even in shallow water on a relatively small site, more than two dives by a dive buddy pair will be required. It is important to note that, while it is ideal to collect as much data as possible in each survey activity, for any and all activities, the survey method is scalable. Only complete as much of each survey sheet as possible within the limitations of your safe diving and conditions. When entering data into the Survey Reporting tab in the GIRT website, the reporting tool only requires a few mandatory data fields from the Surface Sheet. All other data fields need only be populated as data is available.

The GIRT method includes a video transect survey of the site environment, on the site and off the site, which acts as a minimum of environmental data being recorded. However, members are encouraged to also collect data for another established marine citizen science program on their site (undertaking a marine-life survey). Members are also encouraged to include a GIRT diver who is primarily interested in the marine environment in their survey team.

If GIRT members would like guidance on a marine citizen science program, please discuss with your GIRT tutor or email girtscientificdiver@gmail.com.

If you have conducted a survey and find that you need help to organize or interpret your collected data, please contact your GIRT tutor for assistance or email girtscientificdiver@gmail.com. 

[bookmark: _Toc123998901]6 	GIRT RAPID SURVEY
	
[bookmark: _Toc123998902]6.1	    SITE IDENTIFICATION SHEET 

The site identification sheet is one of three core GIRT rapid survey sheets. Members can populate the sheet by ticking boxes, circling identified data or by writing in new information. This sheet does not need to be taken underwater and can be mostly populated on the surface pre-diving (Figure 6). Several data fields in this form can be populated before you are on site. In an attempt to further site formation knowledge, the Site Identification Sheet includes two tables on site formation, ‘Site Classification’ and 'Debris Zone Pattern'. These two tables need to be completed after your dive of the site. 
[image: Diagram, table
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Figure 6 Front and back page of GIRT Surface sheet version. NB: the most recent survey form version is currently labelled Version 3.0 in the bottom left corner of each sheet.

[bookmark: _Toc123998903]6.1.1 	Site Classification

The Site Classification field builds on seminal research published by Keith Muckelroy in 1976. This table includes a ‘Class 6’ category which was not in the initial design. The Class 6  category typically suits metal hulled shipwrecks that have been extensively salvaged. To easily populate this table simply circle the relevant class. For example, circle class 6 and also circle the other applicable descriptive terms in each columns.

[bookmark: _Toc123998904]6.1.2 	Debris Zone Pattern

The Debris Zone Pattern field hopes to further observations recorded on deep water sites in the Gulf of Mexico by Daniel Warren, building on early work by Church et al. 

Distribution Pattern A - 'is identified by debris extending out from around the central hull remains. The wreck debris is distributed over the site unevenly with denser concentrations near the hull structure and lighter scatters on the site's periphery. This type of distribution (Warren) attributed to a ship sinking near vertically to the seafloor and the impact dispersing materials around the impact area (Church et al. 2007)'. p 245


[image: ]

Distribution Pattern B - similar to a site distribution mechanism observed in shallow water. This pattern consists of a trail of wreckage leading to a site with denser concentrations near the core wreckage. On deep-water sites this pattern is attributed to materials continuing to move horizontally through the water column before reaching the seafloor. In this type of pattern, the field density is directly proportionate to the amount of material dislodged from the vessel as it sank (Church et al. 2007).' p245-247.
[image: ]


Distribution Pattern C - is characterised by separate debris scatters. One or more scatters are located away from the core wreckage, while the main scatter is directly related to the main wreckage. In between the scatters, the seafloor is relatively void of wreck-related artefacts.
This type of distribution occurs when materials are dislodged from a vessel on the surface, such as by an explosion, then the ship drifts or moves a substantial distance away from this point without additional loss of ship components, before finally sinking (Church et al. 2007).' p247.


[image: ]


Other - This option is included as all the above models are based on deep-water wrecks and people may or may not be able to choose one of the above distribution patterns. If this option is chosen members should include on their site plan an outline of the distribution pattern.

Reference: Warren, D.J., 2016, Acoustic Positioning and Site Formation on Deep- Water World War II Shipwrecks' in Site Formation Processes of Submerged Shipwrecks, ed. Matthew E. Keith. University Press of Florida, 2016, pp- 235-248.

[bookmark: _Toc123998905]6.2		SITE SKETCH SHEET 

The second of the core rapid survey sheets is the site sketch sheet (Figure 2). On these sheets members are taught to:

a- identify who are the survey participants, the date of the survey, location and site name;
b- how to make an approximately scaled sketch of the site and associated debris field (in meters);
c- include an indicative north arrow on the page and give a compass orientation of the wreck (stern to bow where possible);
d- mark longitudinal survey points 1 -10; and
e- make additional clean copies of the site sketch so as to clearly label features of the site (i.e. bow, stern, engine, anchor, rudder or tail plane, propeller, wing); 
f- add further information about features (depth, temperature, location of photogrammetry scales and their depth (though provision for drawing this is also available on the photogrammetry survey sheet), observations of site condition, marine life, seafloor...); and
g- indicate where the video transect surveys were taken (though provision for drawing this is also available on the video transect survey sheet). 

As indicated below in Figure 7, on the site sketch, number a maximum of 10 features/locations that you intend to use for longitudinal monitoring of the site’s physical condition and sediment movement around the site (it is best to finalise choice of locations for longitudinal survey after discussing the site with your dive buddy). Your choice of the number of places to monitor annually will be based upon only factors you can consider, factors such as: the requirement for effective monitoring; the depth of your site; the size of the area being monitored; current or wave action; the number of distinct features; your accessibility to the site; and the movement of sediments around features.

Once you have a site sketch with numbered survey points you need to populate the legend at the top of the site sketch - key sheet. It is recommended that once you have a site sketch with numbered survey points and a corresponding legend - take a photo/photocopy as a backup of your data and to make a second or third copy so you can write notes underwater without crowding your ‘key’ site sketch with information. This will also help you make a fair copy of all your collected data for uploading into the survey report page of the GIRT website when you complete the survey. Multiple site sketches can be uploaded.

Peter Holt’s website at 3H Consulting has a very good resource on making a site sketch. Peter has a specific section on sketches with good examples that reinforce the fact that everyone can sketch underwater sufficient for the purpose of site monitoring.
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Figure 7: GIRT site sketch survey sheets and a completed example
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[bookmark: _Toc123998906]6.3		PHOTO CONDITION SHEET 

The third and last of the core rapid survey sheets is the photo condition sheet (Figure 3). Prior to entering the water you can partially populate your photo condition sheet (Map grid number and Feature/ location) (Figure 3).

 Tip - Discuss with your dive buddy what order you will do the documentation photos in. Tasks can be split between divers - scribe and photographer. Note that when setting up for the dive you will need your UW camera, photo scale/s, compass, depth gauge, slate with marked site sketch on one side to record data on.

Tip – make sure the date time stamp on your camera is correctly setup. This can help you sort photos.
Separate photos of survey locations by taking a photo of your hand or fin at the end of each survey location’s photo condition documentation. This will help you sort images later on.
If you cannot white balance your camera underwater, at that depth take an image that includes white in it and photos can be colour corrected later.


[bookmark: _Toc123998907]6.3.1 	Place scale and note depth

Place a photo scale near the feature being photographed so that it will be easily visible when you take your condition image of the feature (generally the photo scale is located flat on the ground near the feature or on the feature itself if required). Swim back slightly to be able to get the best general photo of the feature with your camera system. Check your depth measurement so that in following years you can relocate yourself approximately within 0.1 m of the same depth.
Tip – Note the time you took the image of that feature on the survey sheet so you can easily match up images to locations later on.


[bookmark: _Toc123998908]6.3.2  	Orientate yourself

To ensure that the observations will in the future be from a consistent direction, record the compass orientation (+/- 10 degrees) for the photo. Orientate yourself so that you face the survey point from the same direction each time.

Reading a scuba compass
Follow these steps to become more comfortable with your scuba compass.

Step 1: Note that most compasses have numbers marked every 30 degrees. Many substitute East for 90, South for 180, West for 270 and North for 0/360.
Step 2: Rotate the compass back and forth to make it level. The card, the only moving part, should remain stationary and aimed north. Then aim your lubber line toward your survey target.
Step 3: Count the tick marks from left or right of the closest cardinal point to your desired direction. The number it lands on is your heading. Repeat this step to be sure the card is still pointing north and accurate.
(https://www.sportdiver.com/how-to-use-a-compass-underwater-scuba-diving-tips)

[bookmark: _Toc123998909]6.3.3 	Take condition photo

Check that you have framed your photo to include the scale bar at the bottom of the image and the feature.

Remember that the intent of the image is to show the physical condition of the feature, the level of sand cover at the base and or biological growth, or the size and shape of a hole in the vessel. The resolution for the images and your position should enable you to observe the physical condition of the object, the level of sediment piled up to the object and marine growth on the feature. Take a number of images with the scale visible in the view finder so you can select the best image later.

Peter Holt -3H Consulting has a nice piece on taking photos for archaeological purposes. He also has many other useful tips and guides.
http://www.3hconsulting.com/techniques/TechRecordingPhotosOnSite.html

[bookmark: _Toc123998910]6.3.4 	Record Observations

On the sheet, record the feature’s survey number from the Site Sketch Sheet (if not already done pre-dive), the compass direction and depth at which you took the photo to enable future consistent observations. Also, write a short observation of the feature’s condition. Select the best image when uploading data into the SURVEY REPORT page in the website.
Prior to moving to the next feature to document, ensure that you have updated the survey sheet.

See completed example and Figure 8 - Photo Condition Sheet below



	Map Grid No
	Feature /Location
	Time
	Depth

of obs.
	Direction photo taken in
	No of Photos taken
	Observations

	B2
	1 –
exposed timbers
	07.30
	15.5 m
	60 (E – NE)
	3
	Three timbers with borer damage. Dark sand. Lots of seagrass.

	D4
	2 - anchor
	07.45
	6.2m
	180 (S)
	5
	Coarse sand, rocky outcrop nearby
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Figure 8: Photo Condition Sheet



[bookmark: _Toc123998911]6.4 	 GIRT - ADDITIONAL SURVEY ACTIVITIES

[bookmark: _Toc123998912]6.4.1	PHOTOGRAMMETRY FOR GIRT 

One of the most significant advancements in recent years has been the accessibility of photogrammetry to 3-D document features by simply taking images in a particular methodology with at least 60% overlap between each image. Photogrammetry can be defined as both the collection of images in a particular manner and the conversion of those images into a point cloud and scaled 3D model that enables post diving visual analysis, identification of features, measurements, and effective communication of the site to occur. Photogrammetry can greatly facilitate the archaeological process and site management by giving millimetre accuracy and by visually documenting change (termed site formation).

Photogrammetry often uses coded targets like those below. Coded targets help automate certain point measurement tasks and increase accuracy (Figure 9).
[image: ][image: ]
Figure 9: Coded targets used in conjunction with length and colour scale (Wreck Check Inc.) Photo on the right of a Late Bronze Age stone anchor off southern central Cyprus.

Dependent on available time and conditions, GIRT members may wish to do photogrammetry of a specific feature, up to 5 features or of the entire site. Using the Photogrammetry Sheet (Figure 10) draw the position and record the location, depth and unique number/size of each control point/ photogrammetry target. You need to have the depth of a minimum of three targets positioned around the site if you want to correct your photogrammetry for elevation during image processing later, in Agisoft’s Meta Shape software, and to use the data to collect measurements from.
 Tip – Regardless of the controls or scales used it is important to record the depth of each control point/photogrammetry target to help you scale the site in space (X, Y and Z).


As outlined in APPENDIX 1 Photogrammetry guide from Ian McCann (Maritime Archaeological Association of Western Australia (MAAWA) member) ‘it is necessary to set up controls that will allow you to scale and orientate the 3D model’. This document goes into detail about camera setup and data collection.

In addition, Wreck Check’s Dr Andrew Hutchison prepared this video (https://youtu.be/Tbv6bFYyGWY) to assist the Norfolk Island Maritime Archaeology Association collect images for a research project on HMS Sirius. Agisoft also has an enormous range of supporting information on their website http://www.agisoft.com/.

Recognising that most members do not have access to AGISOFT Photoscan/Metashape which is the standard software used to produce a 3D digital model of sites or features, GIRT has purchased a ‘standard edition’ that can be loaned, used and then returned. Instructions on how to load and unload the software is at APPENDIX 2. GIRT members are asked to contact Wreck Check and GIRT member Alex Moss who is acting as the GIRT digital librarian. Details to contact Alex are in APPENDIX 2.

Once you have created a 3D model, you can put your model into the GIRT Sketchfab page (https://sketchfab.com/GIRT) and copy the sketchfab model link to insert it into the survey reporting tool in the GIRT website. 

Detailed guidance on how to post your file on Sketchfab will be developed and posted in the TRAINING pages of the GIRT website. Attached to this document in APPENDIX 3 is how to export your model from Metashape. In the interim please just contact girtscientificdiver@gmail.com until the procedures have been developed.

[image: ]

Figure 10: Photogrammetry Survey Sheet.

[bookmark: _Toc123998913]6.4.2	GIRT VIDEO TRANSECT 

GIRT members can undertake a minimum of two video transect surveys of your site, or more as required. One video transect survey should be on the site itself and one should be off the site. The reason for doing two transects is to show the difference in marine life and growth on the site and what is typically near the site. 

Members should attempt to use already identified survey locations as either the starting and or finishing points of your 30 m transects. If this is not possible select other prominent features on your site. If you choose two starting points that are not pre-selected survey locations you have chosen for photo condition documentation, clearly mark them on the Video Transect Survey Sheet and describe the location.  

To undertake a video transect survey, lay down your 30-meter tape between two features recording the depth at the start and finish of the tape. Choose one direction in which you will always swim and video record, and have the tape start at 0 m. Note that location as starting point A and record the compass direction of the video transect. Swim slowly in the one direction at a height either 1m, 1m-2m, or >2m above the tape and record at a 60-900 angle (height selection is dependent on available visibility). The measuring tape should remain in the middle of the viewfinder with 1 – 3 meters of seabed visible each side of the tape. Note the location of the 30m finish point as location B, recording its depth on the Video Transect Survey Sheet (Figure 11). Draw the survey transects labelling the starting and finishing points and make observations of site features on the sketch.
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Figure 11: Video Transect Survey Sheet.


[bookmark: _Toc123998914]6.4.3	SITE AND CONSERVATION DATA SHEET

The GIRT site and conservation data sheet (Figure 12) comprises many variables that have been used by staff in maritime archaeological conservation from the Western Australian Museum for approximately 40-50 years. Collecting information that can add to their growing data set will assist building up the most comprehensive information about submerged sites that is currently available. The sheet is self-explanatory with many answers being able to be circled from options. Further information about each variable is available in the meta data guidance below at 8.1.5. 

[image: ][image: ]

Figure 12: Site and Conservation Data Survey Sheet.

[bookmark: _Toc123998915]6.4.4	MARINE ENVIRONMENTAL SURVEY

The fourth additional survey option is to use any existing non-intrusive marine environmental survey/citizen science program to document the marine life around their adopted shipwreck. This option is included to encourage members to think holistically about both the natural and cultural features of their adopted site and to be inclusive of other skills in the dive team.

If you have been trained in another citizen science project and can utilise that method on your adopted site, please do so. Any marine environmental data collected will be added to your site’s record as attached PDF documents when entering data in the SURVEY REPORT page of the GIRT website. Any data collected by a GIRT member is welcomed to be shared with the relevant citizen science project.

Examples of marine citizen science projects that can be done in conjunction with GIRT include: Reef Life Survey (https://reeflifesurvey.com/expression-of-interest/ ), ReefwatchSA (https://www.reefwatchsa.org.au/),  ReefCheck (https://www.reefcheckaustralia.org/), Coral Watch (https://coralwatch.org/), Redmap (https://www.redmap.org.au/), and Eye on the Reef (https://www.gbrmpa.gov.au/our-work/eye-on-the-reef (Figure 13). There are different marine citizen science programs all around the world. The choice of marine life survey a member can use is optional.
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Figure 13: e.g. ReefWatch Survey Sheets.

7 [bookmark: _Toc123998916]POST PROCESSING DATA AND SUBMITTING A SURVEY REPORT

[bookmark: _Toc123998917]7.1	SAVE DATA

A key step for any scientific diver is ensuring that their collected data is backed up as soon as possible after diving. While a complete set of raw data (photos, videos, images of survey sheets) should be backed up. Survey sheet data can also be cleaned up and additional data added while information is fresh in the scientific diver’s mind. Once data has been worked up and then backed up, one set of data should be labelled to assist future interpretation (see below) and one set of images should remain unchanged.

Often after diving, data management can take a back seat to other priorities. It is important to plan your day so that you stop diving early enough for you to clean up and save collected data. This is an intrinsic and vital part of the GIRT diving day activities. It is also vitally important, as there is often a time gap between doing the actual survey and post processing and entering the data in the SURVEY REPORT page of the GIRT website. 
 Tip - It is always best to take a photo of the GIRT populated template documents once you are out of the water. This need not be the final version but it backs up data that can be accidentally lost, blurred or rubbed away on the return trip.


A key strategy in immediate data management is to prepare folders on your computer and label them so they are ready to receive data (Figure 14). The main folder should have the site’s name and year or date of the survey. This should help you search for the information in the future. 

Information from different survey team members can be saved in the correct folder with their name.

If you have time on the survey day, or as soon as possible after, it is recommended that you label: individual survey sheets: condition images for each survey point; video transects; and any other files to enable easy later interpretation. The entire folder should then be backed up on cloud storage or on a separate device/portable hardrive/thumbdrive.

For example – 

Figure 14: Example of file folders set up to receive GIRT survey data post diving

The simple steps outlined above will help ensure members can save their collected data, be able to search for their data by keyword (year of survey and name of site), and so that they can more easily submit their report. 

[bookmark: _Toc123998918]7.2	ENTER DATA INTO THE GIRT SURVEY REPORT PAGE

To assist members to add data easily, the GIRT website has been developed to closely reflect the layout of each survey sheet so you can simply transcribe data from the survey templates. The SURVEY REPORTING functionality will guide you through entering data for each field of information in the correct format, adding images, video and other attachments with the correct metadata labels or in the correct file size. 

To start a survey report simply click on the button titled ENTER YOUR SURVEY RESULTS (Figure 15).
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Figure 15: Screen text in members portion of the website.


Every time you first start to enter a survey report, the website will create a shell record from the first page of information (Figure 16). 


[image: ]

Figure 16: Showing what a shell record looks like and its location in the member’s Survey Reporting page.
If you have not adopted a site you will not be able to enter a survey report (Figure 17).
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Figure 17: Showing the dropdown options of adopted sites so that I can select which site this survey report will be submitted.

The website’s current functionality will require you to re access the survey report from the SURVEY REPORTING page, to continue to enter data. It is very important that at the end of each page you press the SAVE button before pressing the NEXT button, otherwise your work will be lost (Figure 18).
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Figure 18: Emphasising the importance of pressing SAVE first to keep inputted data.

Once all the data is added (see Figure 19), you will be able to generate a PDF file that can be downloaded by you. This file can be shared with any relevant management agency so that your site survey report can be added to the site’s permanent record as a statement of its condition on the day it was surveyed.
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Figure 19: A declaration that you are happy to share your data with the public is the last step prior to the survey report being finalised.

[bookmark: _Toc123998919]7.2.1 	Estimating threats and threat level to site preservation

A key role of the GIRT Scientific Diver is to identify actual and possible threats to your adopted site, and assess their likelihood and the subsequent consequence should they occur. This enables the GIRT Scientific Diver to determine a threat level to that heritage’s ongoing preservation. 

As sites are in a ‘dynamic’ equilibrium with their environment, it will take time and experience to know what is normal for your site in its micro-environment and what is a significant change. Initial assessments of risk may be wrong, but these will enable us to learn. Experience will refine your assessment of condition, threat, likelihood, consequence, and risk. As a regular systematic observer of your adopted site’s physical condition, you will be best placed to assess the extent of change in the physical condition and surrounding environment and will be able to support your assessments with observations, measurements, scaled photographs and photogrammetry evidence. Until that experience and evidence is established, your assessment of threat may be moderated, in discussion with you, after being submitted through the SURVEY REPORTING page in the GIRT website.

A site is threatened if there is evidence of cultural or natural activity that has negatively impacted the condition of the site and its future preservation. Below are some examples of activities and their level of threat:

·  Active erosion/totally or partially exposed by a major weather event/current
·  Timber appears newly exposed on the site 
·  Active corrosion 
·  Storm surge
·  Flooding
·  Wave action
·  Vegetation growth
·  Anchor damage
·  Anchors and fishing gear lost on site 
·  Vessel tied of to shipwreck 
·  Loss of concretion cover/coral (diver impact)
·  Evidence of marine borer damage
·  debris around site (bottles, cans, fishing nets, fishing line ... indicating activity over site)
·  Development impact
·  Other

Once you have identified the actual and potential threats to the site:

a) Write a list of identified threats

b) Prioritise those threats in order of significant consequence or potential cumulative effect allocating (minor, moderate, high, major, critical)

c) Consider the likelihood of each threat

d) Identify each threat’s potential consequence level - as either low, medium, high or severe

e) Record the site’s threat and risk level based on the actual threat with the most significant consequence and highest likelihood to the site’s overall preservation.

Threat risk levels:
· Severe – threat has caused damage/loss to the site
· High - threats pose immediate risk, recommend urgent follow up 
· Medium - threats pose a moderate risk, continue to monitor after storm events or on annual basis
· Low - site at minimal risk, monitor after storm events or every 5 years

To assist you in making an assessment use the Threat to UCH matrix below (Figure 20).
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Figure 20: Likelihood of threat’ and ‘Threat to UCH’ matrix below



8 [bookmark: _Toc123998920]METADATA GUIDANCE

Metadata (a set of data that describes and gives information about other data) recommendations are aligned with a diver's standard equipment and use of a camera underwater. All values are recorded in a particular manner to ensure consistency, repeatability, robustness of method and to facilitate comparative analysis. Before diving, cameras need to be set for the correct date and time. Images can be collected in JPEG format, however if divers wish to use the RAW or TIFF/JPEG option. Please note that this may reduce shutter speed when doing photogrammetry.

[bookmark: _Toc123998921]8.1	GIRT SURVEY SHEETS

[bookmark: _Toc123998922]8.1.1	Site identification sheet example

	What data is to be collected:
	Metadata description:

	Site – Name and year of sinking
	i.e. SS Yongala (1911) (Use name in AUCHD. Shipwrecks should be identified by their registered or historically correct name).

	Statutory database number
	AUCHD Shipwreck ID number
(https://dmzapp17p.ris.environment.gov.au/shipwreck/public/wreck/ search.do )

	Which Statutory database
	Dropdown option list auto populated with AUCHD, Needs a chance to type in a database name in another field:

	Number of surveys conducted at this site
	Number of surveys already completed by you at this site.

	Divers name
	First name last name for each diver (i.e. Rick Bullers and Andy
Viduka)

	Divers name
	First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

	Date of Survey
	Format yyyymmdd (i.e. 20180728)

	Time of Survey
	Format 00:00 24 hour

	Location (Latitude)
	In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 19.7654 Longitude -143.1234.

	Location (Longitude)
	In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 19.7654 Longitude -143.1234. Members are required to enter the location data in Degrees and Decimal Minutes format)

	Approximate
location position recorded at
	Select one: Stern, Amidships, Bow

	Datum
	i.e. WGS84, other (free text field) datum



	Position format
	Select one: Degrees and Decimal minutes (GIS), Decimal Degrees (GPS), Degrees, Minutes and Seconds (Charts)

	Distance from Land/Reef
	Select one: 0 - 1 nautical mile (nm), 1 -3 nm, 3 - 5 nm, 5 - 10 nm, >
10 nm

	Current at surface (speed)
	Surface sheet – “(1 knot = 1.85 km per hour)” or (1 knot = 30.1 metres per minutes)”

	
	
Ropes and lines are used by divers for various purposes including to determine the speed of a tidal flow. For example, if a 30-metre line fully extends to its full length in a minute, the speed of tidal flow would be about one knot.

	Current at surface (direction)
	Record compass direction North, North East, East, South East, South, South West, West, North West (i.e. Easterly current). (NB. The direction of ocean currents is the direction they’re headed for or where the current is flowing towards, and the direction of wind is named as the direction from where it’s blowing. So an easterly
current and westerly wind is going the same way or has the same vector - from west to east)

	Tide at survey
	Select one: High tide, Low tide, Ebb tide, Flood tide

	Freshwater/ Saltwater influence
	Select one: Yes - River, Yes - Spring, Yes - Run Off, Yes - Sea Water, No (The preservation of sites can be influenced by a change in the salinity which can impact biological and chemical deterioration. Potential freshwater influence on your site should be
noted).

	Sediment plume visible in water
	Select one: Yes or No. (Generally in tropical environments, large rainfalls cause significant sediment to be washed out to sea, this happens near SS Yongala in North Queensland. Generally the water is dirty with a very low visibility).

	Sea State
	Select one: 0 metres = Calm (glassy), 0 to 0.1 metres = Calm (rippled), 0.1 to 0.5 metres = Smooth (wavelets), 0.5 to 1.25
metres = Slight, 1.25 to 2.5 metres = Moderate, 2.5 to 4.0 Rough (General condition of the surface of the water with respect to wind, waves and swell at a certain location and moment. Use the World
meteorological Organizations sea state code).

	Swell height
	Select one: 0-No swell, 1- Very Low, 2 - Low, 3-Light, 4-Moderate, 5-Moderate rough

	Site Classification
	Select one: Class 1, Class 2, Class 3, Class 4, Class 5, Class 6 (Based on Muckelroy. Refer back of Surface sheet for guidance).

	Debris Zone Pattern
	Select one: Pattern A, Pattern B, Pattern C, Other (from Warren 2016). (Most shipwrecks end up with a debris field associated either with the wrecking event or subsequent post depositional actions. If artefacts are visible around the site, note their approximate location on your site sketch. As artefacts can be moved by natural and cultural activity, the location and distribution of artefacts indicate site formation processes occurring on site).




[bookmark: _Toc123998923]8.1.2	Site sketch sheet 
Metadata description:
What data is to be collected:


	Site Sketch 1 – Key Sheet
	The site sketch sheet is a key visual aid for any other diver to replicate your survey. Draw a sketch of your site and number up to 10 locations where you will do longitudinal survey. In the key features box write a short description of each location (i.e. anchor, engine or boiler..). Attach the site sketch in the survey reporting page as either a PDF or high-resolution JPEG document.

(Labelling files prior to entering results into the website: Date (yyyymmdd format) underscore site name underscore template sheet details
i.e. 20180728_ Star of Greece_sitesketch 


	Site Sketch – Working Copy Sheets
	To avoid a cluttered site sketch which is too busy with
information you have collected, it is better and easier to make a

	(NB: Members can attach up to five PDFS in this section of the survey report. Each PDF can have more than one page if required)
	second or more sketch of your site and add other details to those site sketches. Attach PDF or high-resolution JPEG. 

(Labelling files prior to entering results into the website: Date (yyyymmdd format) underscore site name underscore template sheet details
i.e. 20180728_ Star of Greece_sitesketch2 




[bookmark: _Toc123998924]8.1.3	Photo condition sheet 

	What data is to be collected:
	Metadata description:

	Site – Name and year of sinking
	i.e. SS Yongala (1911) (Use name in AUCHD. Shipwrecks should be identified by their registered or historically correct name).

	Location (Latitude)
	In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 19.7654 Longitude -143.1234.

	Location (Longitude)
	In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 19.7654 Longitude -143.1234.

	Datum
	i.e. WGS84 datum

	Divers name
	First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

	Divers name
	First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

	Date of Survey
	Format yyyymmdd (i.e. 20180728)

	Site Sketch Grid no.
	Select a letter: A - N and a number: 1 - 13



	Feature/Location
	Number of Survey Point taken from Site Sketch (i.e. SP 1
-10)

	Time photos were taken
	Format 00:00 24 hour

	Depth of diver observation
	000.0 meters. The relationship of the diver taking the image to the object is captured here to assist future photographers to be in the same space facing in the
same direction.

	Direction photo taken
	i.e. 60 (E – NE)

	Number of photos taken
	This is to indicate if there are other photos that may be accessed later if required. Personally, I always take more than one photo so I can choose the best image. Between survey points I take a photo of my hand between survey points so when I am reviewing images of a survey I can easily differentiate between photo
sequences.

	Observation of exposed artefacts physical condition, biological growth and sediment cover
	Max 500 characters

	Attach best condition image*

(*Up to 10 records can be entered)
	Attach PDF, JPEG or high-resolution TIFF. Label condition images of features. Date (yyyymmdd format) underscore site name underscore template sheet details. i.e. 20180728_ Yongala_sp1_image1 
[sp1 = Survey Point (and number allocated from 1 – 10)]



[bookmark: _Toc123998925]8.1.4	Photogrammetry sheet
	
	
                                    Photogrammetry (annotate the site sketch)

	Unique scale number or description of scale
	Describe the scale (i.e. 1m white, 0.5m white and black and 1m orange)

	Depth of scale
	Regardless of the controls or scales used it is important to record the depth of each control point/photogrammetry target to help you scale the
site in space (X, Y and Z).

	Location of scale (i.e. Site sketch grid number)
	Indicate the approximate location of each unique scale and its depth on a site sketch.

	Description of location being imaged and relevant survey point number if applicable
	This is to indicate if there are other photos that may be accessed later if required



[bookmark: _Toc123998926]8.1.5	Site and conservation data sheet 

	What data is to be collected:
	Metadata description:

	Site – Name and year of sinking
	i.e. SS Yongala (1911) (Use name in AUCHD. Shipwrecks should be identified by their registered or historically correct name).



	Location (Latitude)
	In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 19.7654 Longitude
-143.1234.

	Location (Longitude)
	In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 19.7654 Longitude
-143.1234.

	Datum
	i.e. WGS84 datum

	Divers name
	First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

	Divers name
	First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

	Date of Survey
	Format yyyymmdd (i.e. 20180728)

	Time of Survey
	Format 00:00 24 hour

	Water temperature at surface
	(usually +/-0.1 in degree Celsius)

	Visibility in water
	Select one: <5m, 5-10m, >10m (Through water visibility).

	Current on site (direction)
	Record compass direction i.e. Easterly current. (NB. The direction of ocean currents is the direction they’re headed for or where the current is flowing towards, and the direction of wind is named as the direction from where it’s blowing.
So an easterly current and westerly wind is going the same way or has the same vector - from west to east)

	Current on site (speed)
	i.e 0.5 knots

	Site Orientation
	Select one: Upright, upside down, lying on port side, lying on starboard side, listing to port, listing to starboard.

	Site compass direction of wreck (stern to bow)
	Use 000 degrees and 16 point compass term (i.e. 90 degrees E) (gives approximate direction of travel)

	Evidence of structural collapse
	Select one: Yes or No.

	Evidence of structural collapse - image and depth
	If yes, Depth is recorded in meters (00.0)


	Evidence of structural collapse - image
	Photograph and indicate where on the site sketch. This informs the site classification question on the surface data sheet Attach PDF, JPEG or high-resolution TIFF. Label condition images of features. Date (yyyymmdd format) underscore site name underscore template sheet details. i.e. 20180728_ Yongala_sp1_image1	
[sp1= Survey Point (and number allocated from 1 – 10)]

	Composition of dominant wreck material visible
	Select one: Iron, aluminium, wood/timber. (If other than these materials please list under other)

	Location deepest point on wreck
	Short description - 100 characters. Mark location on site sketch.

	Depth at deepest point on wreck
	Maximum depth is recorded at the deepest point on the site. Depth is recorded in meters (00.0) (To be determined by you with reference to depth gauge (typically depth gauges have a +/- 0.1m accuracy). Place hand with depth gauge on top of identified location).

	Water temperature at deepest point on wreck
	Degrees Celsius (usually +/-0.10C error in dive computers)

	Site Dimensions - length
	In meters. To be used to calculate area: (Length (m)) x (Width (m)) = Area in m squared

	Site Dimensions - width
	In meters. To be used to calculate area: (Length (m)) x (Width (m)) = Area in m squared

	Mobility of Sediment Surface (rippling, direction)
	Take a compass bearing on the direction of travel of ripples use 000 degrees and 16-point compass term (i.e. 90 degrees E). To assist calculating the frequency of a repeating event - determine the number of times that event occurs within a specific period, then dividing the count 30. For example, if 15 events occur within 30 m the frequency = 15/30 = 0.5 ripples per meter. To assist in determining this lay down the 30m tape measure and count the number of ripples over that distance.

	General Seabed Topography near site
	Select one: Flat, crest, slope

	Sediment Colour Gradation (changes in colour over the area of the site)
	Select one: Yes or No. (Changing colour of sand over the site may indicate different conditions for preservation or recent scouring or deposition).




	Sediment Colour Gradation
- image
	Photograph with scale and indicate where on the site sketch. This informs the site classification question on the surface data sheet Attach PDF, JPEG or high-resolution TIFF. 

Label condition images of features. Date (yyyymmdd format) underscore site name_ underscore template sheet details. i.e. 20180728_Yongala_sp1_image2;	
[sp1= Survey Point (and number allocated from 1 – 10)]

	Sediment Slope near wreck (gradient)
	Select one: Flat, slight incline, steep incline. (Swim length of site noting depth change from bow to stern, 1-2m flat, 2 - 4 meters slight incline, > 5 steep incline)

	General composition seafloor (coral, limestone outcroppings, sand, boulders, pebbles, clay, seaweed, seagrass)
	Select relevant: Coral, Limestone outcroppings, Sand, Pebbles, Boulders, Clay, Seaweed, Seagrass. (The preservation ability of sediment in the marine environment is linked to the size of the sand grains (larger particles allow more oxygen access into the sediment column), the amount of organic detritus included within the sediment column and the rate and extent of the physical agitation of the deposit.
Lighter coloured and red/brown sands (containing iron ions) are typically oxygenated and include sessile marine organisms (bryozoans, sponges, ascidians and tunicates and marine borers (molluscs or crustaceans). Black sand is usually anaerobic (no oxygen) where sulphate reducing bacteria predominate as the mechanism for deterioration.
These sands help preserve shipwrecks by significantly changing the rate of deterioration.	Sand can range from very coarse (1.0 -2.0 mm) per grain, through medium sand
¼ - ½ mm to silt < 1/16 mm. Pebbles are approximately 4- 64 mm each, cobbles 64 -256 mm and boulders > 256 mm. Underwater it is impossible to gauge this by eye and sampling does not align with GIRT’s ‘no impact’ research approach. Members are asked to assess by eye whether the sediment over the site comprises of Coral, limestone outcroppings, boulders, cobbles, pebbles, sand, silt. More than one can be chosen and an approximate proportion can be indicated for each.)

	Vegetation cover on seafloor
	Select one: 0-20%, 21- 40%, 41 -60%, 61 - 80%, 81-100%

	Percentage of concretion (fouling organisms) coverage on exposed wreck material
	Of the visible portions of the wreck, approximately how much of the exposed material is covered in concretion or other marine growth. Give results as a percentage, i.e. 70%



	Evidence of recent active corrosion
	Select one: Yes or No. (Corrosion is indicated by the appearance of red active areas on iron. Sometimes gas can be evolving from cracks in concretion).

	Evidence of recent active corrosion - depth
	If yes, Depth is recorded in meters (00.0)

	Evidence of active corrosion - image
	Photograph with scale and indicate where the most active corrosion is ocuring on the site sketch. Attach JPEG or high resolution TIFF. Label condition images of features. Date (yyyymmdd format) underscore divers name underscore divers name underscore AUCHD Shipwreck ID number for your site underscore template sheet details. i.e.
20180728-_ viduka_bullers _5748_4sp1_image1 20180728_viduka_bullers_5748_4sp1_image2; 20180728_ viduka_bullers _5748_4sp2_image1	[sp1
= Survey Point (and number allocated from 1 – 10)];

	Evidence of Seasonal or storm/cyclone exposure
	Select one: Yes or No.

	Types of fouling organisms on wreck
	Select one: Yes or No. (NB: fouling organisms are animal or plants attached to surface of the site)

	Types of fouling organisms on wreck - image
	Take a photo of the dominant looking type of marine fouling organisms. Label and attach up to 10 images with scale.
Attach JPEG or high resolution TIFF. Label condition images of features.Date (yyyymmdd format) underscore divers name underscore divers name underscore AUCHD Shipwreck ID number for your site underscore template sheet details. i.e. 20180728_ viduka_bullers
_5748_4sp1_image1 ; 20180728_viduka_bullers_5748_4sp1_image2; 20180728_ viduka_bullers _5748_4sp2_image1	[sp1
= Survey Point (and number allocated from 1 – 10)]

	Evidence of timber Infestation by marine borers
	Select one: Yes or No.

	Evidence of timber Infestation by marine borers - image
	Photograph with scale and indicate where the most active marine borer activity is occurring on the site sketch. Attach JPEG or high-resolution TIFF. Label condition images of features. Date (yyyymmdd format) underscore divers name underscore divers name underscore AUCHD Shipwreck ID number for your site underscore template sheet details. i.e. 20180728_ viduka_bullers _5748_4sp1_image1 ; 20180728_viduka_bullers_5748_4sp1_image2; 20180728_ viduka_bullers _5748_4sp2_image1	[sp1
= Survey Point (and number allocated from 1 – 10)]



	Is contemporary rubbish present around the site (Yes, No) Indicate on site sketchwhere image/s taken.
	Select one: Yes or No. Indicate on site sketch.

	Is contemporary rubbish present around the site
	Select relevant: Beer cans, glass bottles, fish nets, fishing line, tyres, plastic, rope, other (100 characters to type in what other is)

	Approximate no. of pieces of rubbish around site
	Select one: 0-20, 21-40,41-60,61-80,81-100, >100

	Evidence of Human Disturbance
	Select one: Yes or No. (If yes option to add more than one record) Indicate on site sketch.

	Evidence of Human Disturbance - description
	Select relevant: Anchor damage, digging, objects moved, broken timbers, exposed artefacts, other (100 characters to type in what Other is)

	Evidence of Human Disturbance - depth
	If yes, Depth is recorded in meters (00.0)

	Evidence of Human Disturbance - image
	Photograph with scale and indicate where the evidence of human disturbance occurred on the site sketch. Attach JPEG or high resolution TIFF. Label condition images of features. Date (yyyymmdd format) underscore divers name underscore divers name underscore AUCHD Shipwreck ID number for your site underscore template sheet details. i.e. 20180728_ viduka_bullers _5748_4sp1_image1 ; 20180728_viduka_bullers_5748_4sp1_image2; 20180728_ viduka_bullers _5748_4sp2_image1	[sp1
= Survey Point (and number allocated from 1 – 10)]

	Sediment build up on site or around features
	Select one: Yes or No. Indicate on site sketch.

	Sediment build up on site or around features - depth
	If yes, Depth is recorded in meters (00.0)

	Sediment build up on site or around features - image
	Photograph with scale and indicate where the evidence of sediment build up occurred on the site sketch. Attach JPEG or high resolution TIFF. Label condition images of features. Date (yyyymmdd format) underscore divers name underscore divers name underscore AUCHD Shipwreck ID number for your site underscore template sheet details. i.e. 20180728_ viduka_bullers _5748_4sp1_image1 ; 20180728_viduka_bullers_5748_4sp1_image2; 20180728_ viduka_bullers _5748_4sp2_image1	[sp1
= Survey Point (and number allocated from 1 – 10)]



	Location highest point on wreck
	Short description - 100 characters. Mark location on site sketch. Minimum depth is recorded at the shallowest point on the site. Depth is recorded in meters (00.0) (To be determined by you with reference to depth gauge (typically depth gauges have a +/- 0.1m accuracy). Place hand with depth gauge on top of identified location).

	Depth highest point on wreck
	Depth is recorded in meters (00.0). Minimum depth is recorded at the point on the site/wreck closest to the surface

	Temperature highest point on wreck
	Degrees Celsius (usually +/-0.10C error in dive computers)

	
Exposed Artefacts

	Materials
	Select one: Metal, Ceramic, Glass, Stone, Rope, Timber, Leather, Textile, Skeletal, Unidentified

	Object description
	Short description - 100 characters

	Apparent Condition
	Select one: Very Poor, poor, Fair, Good, Excellent

	% Degree of Completeness
	Select one: 0-20, 21-40,41-60,61-80,81-100

	Image
	Up to 10 images can be added in the survey report. Photograph with scale appropriate to object size. Attach JPEG. Label images immediately after fieldwork to ensure accurate post processing. Date (yyyymmdd format) underscore divers name underscore divers name underscore AUCHD Shipwreck ID number for your site underscore template sheet details. i.e. 20180728_ viduka_bullers
_5748_ExposedArtefact1_image1 ; 20180728_viduka_bullers_5748_ExposedArtefact1_image2; 20180728_ viduka_bullers _5748_Exposed
Artefact2_image1

	Depth
	If yes, Depth is recorded in meters (00.0)

	Location
	Short description - 100 characters. Mark location on site sketch.

	Time photo taken
	Record time in 24 hour clock 00.00 hours. Recorded to assist post fieldwork processing by correlating the written record with the date time stamp in the image metadata.







[bookmark: _Toc123998927]7.1.6	Video transect sheet 

	What data is to be collected:
	Metadata description:

	Site – Name and year of sinking
	i.e. SS Yongala (1911) (Use name in AUCHD. Shipwrecks should be identified by their registered or historically correct name).

	Location (Latitude)
	In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 19.7654 Longitude -143.1234.

	Location (Longitude)
	In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 19.7654 Longitude -143.1234.

	Location (Datum)
	i.e. WGS84 datum



	Divers name
	First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

	Date of Survey
	Format yyyymmdd (i.e. 20180728)

	Camera system and lens
	Free text field 100 characters

	Video format
	MP4, MOV, WMV or AVI. (Circle one)

	Time – length of recording
	Recorded in minutes and seconds (i.e. 1min 50sec)

	Site Sketch Grid no.
	Select a letter: A - N and a number: 1 – 13 on the key Site Sketch sheet to indicate where point A of the video transect survey is located.

	Name / description of Location A
	Free text field 100 characters

	Depth at Location A
	000.0 meters

	Compass bearing from A to B
	i.e. 60 (E – NE)

	Height of swim over from A to B
	<1.0 m 1-2m, 3m, >3m (tick one)

	Observation of exposed artefacts physical condition, biological growth and sediment cover
	Max 500 characters



[bookmark: _Toc123998928]8.1.7	Other marine survey 

	What data is to be collected:
	Metadata description:

	What type of survey is this?
	Dropdown options (i.e. Reef Check, Red Map, Eyes on the Reef…..) which can be initially populated by administrator. Need to have a list that includes the chance for members to select 'Other' and add free text.



	Marine Survey Sheet 1*
	Attach PDF, JPEG or high resolution TIFF (Labelling Marine

	(*Maximum of five PDFs or images can be loaded under this field)
	Survey PDFs - save file as: Date (yyyymmdd format) underscore divers name underscore divers name underscore AUCHD Shipwreck ID number for your site underscore template
sheet details i.e. 20180728_viduka_bullers_5748_MS_(name

	
	of type of marine survey)

	
	i.e.20180728_viduka_bullers_5748_MS_Reefwatch [Star of

	
	Greece is Shipwreck ID Number 5748 in the Australasian

	
	Underwater Cultural Heritage Database; [MS = Marine Survey.

	
	Reefwatch, Coral Watch, Redmap, Reef Check and Eye on the Reef])



[bookmark: _Toc123998929]8.2	THREAT AND RISK LEVEL DATA 

	What data is to be collected:
	Metadata description:

	Identify the threat*

(*Up to 10 threats can be entered)
	100 characters. (eg. The site been totally or partially exposed by a major weather event)

	Identify the likelihood of the threat
	Select one: 0-10%, 10-29%, 30-59%, 60-79%, 80-100%

	Identify the threats consequence
	Select one: minor, moderate, high, major, critical

	Record the site's Threat and Risk level based on the threat with the most significant consequence and highest likelihood to the site's overall preservation
	Select one: Low, Medium, High, Severe (NB. The selection of one of these variables changes the colour of the site on the ADOPT WRECK map page)



	Low

	Medium

	High

	Severe



[bookmark: _Toc123998930]APPENDIX 1 - 3D PROCEDURES FROM IAN MCCANN – MAAWA MEMBER

[bookmark: _Toc123998931]Practical Approach to 3D Photogrammetry

The following techniques describe a low budget approach to 3D photogrammetry. This approach uses low cost or free software and rapid capture to produce a basic 3D model that is suitable for a simple site plan. Its simplicity and user friendly software means it can be used as a tool by most people, from the professional archaeologist to recreational divers. If the steps outlined are followed, models of high accuracy can be produced allowing precise measurements to be taken from them. Detailed site models and recordings of excavations are very important for post excavation study, and while currently this low cost approach will not replace traditional recording techniques, the rapid development of cameras, computers and programs means this may not be too far away.
An important facet of this technique is expectation, if you want a model with fine detail and all you have is; a single person, limited time and low end equipment, then you may well be disappointed.
So ask these questions: Why is the site being recorded? How is the model going to be used? What’s the budget? What level of skill is available?
If all that’s required is a rapid site survey for an initial assessment, then this approach will become an essential tool for maritime archaeology.
[bookmark: _Toc123998932]Equipment Requirements

[bookmark: _Toc123998933]Cameras

[image: ]Almost any camera will work, from a smartphone to a high end DSLR. What will vary is the quality of the 3D model produced from these different cameras. It’s not all about pixels, either: a 16 mega pixel smartphone, which has a small sensor, will not produce as good a picture as one taken by a 16 mega pixel camera with a large sensor. Putting more pixels on a small sensor doesn’t improve pixel resolution. As shown in the image to the right, the ‘full frame’ sensor has larger pixels than the others. The larger the pixel the more light is collected, and therefore produces a picture with superior dynamic range and less noise.
This is a bit of over simplification, there are a lot more factors
involved with image quality but it’s one of the most misunderstood aspects of digital cameras. Video can also be used from which screen grabs or captured images can be generated, this data will produce acceptable models. GoPros have been particularly successful due to their ease of use, good depth of field and acceptable quality. Extracting data from video using Photoshop is shown further on in this procedure. Using a GoPro won’t give a detailed model, but it will produce a basic model suitable for an initial site assessment.
Using a camera underwater (unless waterproof) necessitates the use of an underwater housing which can cost more than the camera. However, there are a number of more affordable alternatives available that can be just as effective. I’ve been using a cheap housing for a Sony Nex camera for over three years to 40m with no leaks. Just remember: buyer beware.

[bookmark: _Toc123998934]Settings for the Cameras

[bookmark: _Toc123998935]Shutter Speed

A fast shutter speed is necessary to produce sharp images.

When taking a photo, it’s important to be as still as possible. However underwater this is more challenging, and a faster shutter speed will help compensate for any motion and minimize blur. This is desirable as motion blur reduces the amount of recognizable data for the program to analyse, and can result in a poor model.
[bookmark: _Toc123998936]Aperture

Depth of Field describes the portion of the image in focus, and therefor it’s ideal to get the greatest depth of field possible. F22 will give a better depth of field than F4.5. However, as long as the area you want to capture in that frame is in focus, then other frames can fill in the blurred data during processing.
[bookmark: _Toc123998937]ISO

With modern cameras the ISO can be pushed beyond 100,000. Doing so means a higher quality photograph in lower light conditions can be captured because a faster shutter speed and a higher aperture can be used.
[bookmark: _Toc123998938]Lenses

The better the lens optics the better the level of detail, which translates into better data for the software to process and fewer number of images that need to be taken overall.
Ultra-wide angle lenses cause more distortion in the image and this can cause problems in processing, however consistently good results can be obtained with wide angle lenses of 15mm and greater, with very good pair matching in processing. The advantage of the wide angle lens for the diver is that you can get closer to the subject, which results in fewer particles or backscatter in the picture, and can therefore produce better photographs.
[bookmark: _Toc123998939]Quality

This really comes down to the processing speed of your computer and the graphics card. It’s best to capture the highest quality image your camera can manage, as the size or resolution can always be changed later in a batch editing package, such as IM Batch (www.highmotionsoftware.com/products/imbatch).
Your computer may not be able to handle a large number of high quality images which may mean slow, or no, processing. Getting the best quality data also future proofs your work. As computers get faster and software more sophisticated, processing these high quality images in the future will become more manageable. Photoscan recommends 5mp and upwards to get good consistent results.

[bookmark: _Toc123998940]Editing images

If the information in this procedure is followed this step shouldn’t be needed. If editing is required then using the auto button on most packages will improve the photographs. If you are having trouble with the photographs aligning then adjusting the contrast can help.

[bookmark: _Toc123998941]Additional light sources

In a studio or controlled environment extra light sources may be manageable. Softboxes, reflectors or just bouncing light off the walls or ceilings can give an even spread of light. However without a bit of experience, the use of an additional light source in 3D photogrammetry will cause problems, the main one being an increase in shadows (also called caustics). Shadows will create blank spaces in the models because detail is hidden by these shadows.
[bookmark: _Toc123998942]Software

There are currently over forty software packages available for 3D photogrammetry ranging from Autodesk 123D Catch, a free phone App, www.123dapp.com/catch , through to Simactives Correlator3D designed to process satellite data. For this introduction to photogrammetry we’ll be using Agisoft Photoscan it has almost become the default programme for this technique due to its user-friendly workflow. Photoscan’s workflow is basically acquiring images, feature extraction, 3D surface generation, and texturing.
If you don’t have access to Agisoft Photoscan, either the standard or professional edition, then you can download a trial license for 30 days, http://www.agisoft.com/downloads/request-trial/.
The trial will let you try everything except exporting and saving your model. The requirements to run this programme are:
Minimum Configuration

· Windows XP or later (32 or 64 bit), Mac OS X Snow Leopard or later, Debian/Ubuntu (64 bit)
· Intel Core 2 Duo processor or equivalent

· 2GB of RAM

Recommended configuration
· Windows XP or later (64 bit), Mac OS X Snow Leopard or later, Debian/Ubuntu (64 bit)

· Intel Core i7 processor

· 12GB of RAM

At 10 MP per photo, 2GB RAM is sufficient to make a model based on 30 photos, 12GB RAM will process up to 300 photographs per model.
The practical outlined later will only take you up to producing a 3D model on your screen as you can’t export or save the model with the trial license.
The free program Meshlab is needed to scale the model if the standard version of Photoscan is being used.
https://sourceforge.net/projects/meshlab/files/meshlab/MeshLab%20v1.3.3/

[bookmark: _Toc123998943]Underwater

Many of the unique challenges posed by taking photographs or video underwater can be addressed by good dive planning and preparation. A site visit or using online resources prior to a recoding run can be valuable. It’ll inform as to the nature of the site; in terms of depth, currents, tides, visibility, access/egress, and potential complications.
For example if the site is in shallow water then SCUBA may not be needed but the snorkelers may be exposed to increased water movement from tides, current, wind or swell. Shallow water sites, less than 3 metres, can have lighting problems due to wavelets causing light to be refracted through the surface of the water so that it illuminates the target with a constantly changing light pattern.
[image: ]
If these conditions are encountered then shoot early in the morning or late afternoon.

The size and complexity of the site will dictate the patterns of the recording runs and how many additional sections will need more detailed recording. If the vessel has collapsed and has a fairly low profile then, the recoding runs are fairly straightforward. If there are elevated features, such as engines, deck winches, a wheel-house or even anchors then separate recording runs will be needed and these processed with the main body of data. Wrecks with fairly intact hulls may need multiple recording runs at different times of the day when the natural light will illuminate different parts of the wreck, this will help reduce shadows which hide data. If there isn’t sufficient overlap of photos or the pattern is too simple, areas hidden by shadow or parts of the wreckage will result in voids in the model. In the figure below diver 1 will miss areas obscured by some of the wreckage (the red shaded section), with a second run diver 2, with the recommended overlap, will help cover most potential voids.
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The diagram below is a suggested pattern to swim for capturing photos on wrecks, overlaying two swimming patterns will help capture areas that may be hidden by the wreckage it’s self.


[image: ]
Additional light sources can reduce or eliminate shadows but if not used correctly it can increase them. They can also cause backscatter, this is where the light reflects off particles in the water between the object and the lens, again hiding detail.
Using a wide angled lens or getting closer to the target can help manage low visibility or lack of available light during a heavily overcast day, depth or particles in the water. This will also add to the number of photographs and commensurately increase the site recording time. The diver will also have to move slower and allow for more overlap.
[bookmark: _Toc123998944]On Land

Strong light, shadows and anything moving in the area being scanned can reduce the ability of the program to process the captured data. As with diving, choose the early morning or afternoon to capture data when the light can be more even. If shooting a small object outdoors, a shady spot is the best. If shooting indoors, choose a place away from any direct sunlight or widows, look for a position where the light is nice and even.

[bookmark: _Toc123998945]General Guidelines

Almost any camera can be used as long as the basic recommendation for capturing images is followed. When recording a site it’s important to keep the camera, lens, and settings the same. To speed up processing time the resolution of the camera can be set as low as 5MP.
Lenses between 15-20mm work well for larger sites whilst a 50mm lens will work for a single item like a small pot.
If using a Gopro for photographs or video the ultra-wide setting, 170 degrees, causes too much distortion in the image and results in having a greater number of rejected images in the photo alignment.
Images captured using ultra-wide lenses can be adjusted for lens distortion but this just means more work.
For still images, a Gopro can be set on the time-lapse mode and 0.5 seconds per frame, this works well most sites.
Record the images in a set pattern ensuring an overlap of 50-75%, with a side overlap of 25- 50%. A feature that is recorded in multiple photo’s and can be identified by the software is essential for creating the geometry needed to create a 3D model.




[image: ]


If it’s a smaller target then get a few general shots of the item before shooting the closer ones for more detail.
The two figures below show a pattern used for a small pot. They indicate the camera position and angle. Starting with some general shots, to establish the form, move systematically around the pot allowing for the recommended overlap. This is repeated at different angles and heights until all details are captured.

[image: ]

This pattern is also used to capture individual features on a larger target. If the pot had a larger belly or was a bowl with a wide, low flare then more images are needed at a lower angle to record all areas of the pot.
For larger sites a “lawn mowing” pattern is often the best as in the diagram below. The closer to the site you are, the more runs will be needed to get the overlaps.
[image: ]
If insufficient photographs are taken or not enough points matched in processing due to shadows, reflective surfaces or motion blur then voids or distortions in the model will be visible, as in the images below.
[image: ]
[bookmark: _Toc123998946]Targets for Measurement

To enhance site recording beyond just a simple model for illustration, the use of scales for measurement is important. These may be anything of a known length, such as a scaling pole or simply a measurement between two significant fixed features on the site. Whatever is used should be of a non-reflective, matt surface and placed in a position where multiple photographs from different angles can ‘see’ them. Getting the correct orientation of the model can be made easier by the ensuring the scale is level by using simple bubble levels, see photograph below.


[image: ]
[bookmark: _Toc123998947]Recording

Once the best capture method has been determined, and a scale has been included, then the data capture can commence. Following the image capture pattern, moving or swimming as decided will ensure a full coverage of the site. It is important to be moving at a steady rate, allowing for the overlaps while not over-imaging one area.
When shooting directly down, plan, keep a 5-degree angle ‘up’ this can help produce better results.
Keep the same distance away from the subject, if it’s on a slope follow the contour down. For example, if a 4-metre standoff from subject is being used try and maintain that at all times. For larger sites where most of the photographs are taken in plan, capture at least a couple of metres beyond its actual area. This will help in the processing, some models produce bends on their edges and these can be cropped if there are unwanted areas.
Once the “plan” run is done capture any features or parts of the site with any elevation. Try and get any overhangs or areas where data may be hidden and angle the camera so less of the unwanted background is captured.
The following exercises will break the process down into simple dot points and should produce suitable data for processing.
[bookmark: _Toc123998948]Exercise 1 Items needed:
Small ceramic pot

Piece of neutral coloured matt material Scale
Small table or stand

A place with an even light 

Camera


Method:

· Place the material on a small table or something to raise it up off the floor, preferably the cloth will cover the surface of the stand.
· Place the pot on the cloth and the scale close to its base.

· Make sure you can walk around the pot and can keep a constant distance away from it. For a 30cm high pot try a 45cm standoff. This distance will vary according to the shape and volume of the item, there’s no correct distance. Too close and the program can’t build a model, too far away and the detail will be poor. Trying to scan a variety of items to get experience at to what standoff is best for different items.
· Use the auto setting on the camera.

· Take four photographs from above the pot, plan shots, at even spaces whist moving around the pot. Remember to keep the camera steady when taking the photos.
· On the next pass move down the pot, shoot the photos with the camera at approximately 30 degrees to the pot, taking around eight pictures at even spaces.
· Move down again and have the camera at approximately 45 degrees, again taking eight photos.
· Lastly move down again with the camera at 90 degrees to the pot and again take eight photos.
The data can now be processed.

The following screen captures show an image capture pattern used to record a 1 metre section of timber.
[image: ]

[image: ]

[bookmark: _Toc123998949]Exercise 2 Items needed:
Scale Camera

     Method:

Choose a larger feature, part of a garden for example.

· Walk around it and work out how it can be recorded efficiently and methodically.

· Place a scale.

· Take several establishing shots so the program can make sense of what’s there. These should try and cover the whole area per shot and be taken from different angles.
· Start from one point on the corner of the area to be recorded.

· Take the photos with the camera at approximately 45 degrees to the ground.

· Take the first photo, step forward and take the next.

· Keep repeating this, possibly using the pattern shown below.

· Once the plan shots are completed assess if there are any features that could be added.
· Choose one and apply a capture pattern similar to the pattern used to capture the post in exercise 1. These Photos can be imported together by combining the files or as separate files or chunks.


Process the data.

[image: ]

[bookmark: _Toc123998950]General workflow

· The general workflow for processing images is:

· Capture image / Stills / Process in Photoscan

· Capture image/ Video / Extract Stills / Process in Photoscan

[bookmark: _Toc123998951]Extracting Stills from Video

· Open Photoshop

· File > Open > Choose video file of subject > Open
[image: ]


[image: ]

File > Export > Render Video




[image: ]


Render Video Box:

Name > Name your file
Select Folder > Select folder destination Create New Subfolder> Do not tick Photoshop Image Sequence > JPEG

Frame rate > Custom FPS > 5FPS
Render

The files will now export. Finally check the files have been exported.

[bookmark: _Toc123998952]Processing the data in Photoscan

PhotoScans workflow is very easy to follow. At each stage a dialogue box will open informing you of the progress of each step.
[bookmark: _Toc123998953]Add photos or files

Open Photoscan > File > New

Workflow > Add photos or add folder > Choose photo’s or folder’s > Open

The photos will now be loaded and will be referred to as a Chunk, visible on the left hand side of you screen. It will also show the number of cameras, each camera is a photograph.
[bookmark: _Toc123998954]Align Photos

Workflow > Align Photo’s > Accuracy: Medium > Pair Selection: Generic > OK

Pixels will now compared to find matches, work out camera location and produce a sparse point cloud. At this point the form of the item can often be recognized.
[bookmark: _Toc123998955]Build Dense Cloud

Workflow > Build Dense Cloud > Quality > Medium > OK
Significantly more points are produced to where the dense cloud appears as a solid model when zoomed out.
[bookmark: _Toc123998956]Build Mesh

Workflow > Build Mesh > Surface Type: Arbitrary > Source Data: Dense Cloud > Face Count: Medium
Faces are created over the model by connecting the points to make a continuous Mesh.

[bookmark: _Toc123998957]Build Texture

Workflow > Build Texture > Mapping Mode: Generic > Blending Mode: Mosaic (default)
>Texture Size/Count: Use recommended, 4096 x 1 > OK

A texture map is wrapped around the model creating a photo realistic 3D model.

[bookmark: _Toc123998958]Orientation

When initially processed, the model is often upside down and needs to be correctly oriented.

To do this turn off the perspective view, this is shown in blue in the top left hand corner of the screen:
View > Perspective/Orthographic, select. The view you are now in will be shown in blue on the screen.

Next

View > Predefined Views > Top Select “Rotate Object” in the toolbar.
[image: ]

By using the cursor, highlighting one of the coloured bands on the sphere, red, green or blue, the ball the model can now be rotated in any direction. If the scale used for the model has been levelled, using simple bubble levels, the model can be orientated to that level.


[image: ]

Orientate the model to match the view selected, then click on the Navigation icon to lock the change.
[image: ]
When that model is next opened in Photoscan it will be in that orientation.

Photoscan models can be exported to other program such as Blender for animation and rendering and Sketchfab for file sharing. Export formats include .stl that can be used for 3D printing.
[bookmark: _Toc123998959]Scaling

This can’t be done with the trial version of Photoscan. With the standard version the model needs to be exported to Meshlab. First the model needs to be exported in a different format, a PLY file.
File > Export Model > File Type > Stanford PLY > Save

Next open Meshlab and import the model. File > Import Mesh > choose model file (*.ply). With the cursor click the Tape Measure Tool
[image: ]

Use the Tape Measure Tool to measure a known distance.
[image: ]
An arbitrary distance will be shown, here it’s 2.72515.

Knowing the scales length, 1 metre, we divide 1m by 2.72515 so the scaling factor is 0.367. To re-scale go to:
Filters > Normals, Curvatures and Orientation > Transform Scale > click
[image: ]
A Transform: Scale dialogue box will open. Input the figure 0.3670 into the boxes for the X, Y, and Z axis and check the Uniform Scaling box is ticked, then apply.
[image: ]
Using the Measuring Tool any part of the model can now be measured.

To save the model export it, remembering to give the file a new name so the original is not overwritten:
File > Export Mesh As > select Stanford Polygon File Format (*.PLY) > Save.

At any stage of the processing editing tools can be used to delete selected parts of the point cloud or sections of the model after building mesh or texture. This will reduce processing time as well as refining the model. The red square encloses the shaped selection tools, the green circle a standard crop tool and the yellow the delete button.
[image: ]

This is only a basic approach to 3-D photogrammetry using the free or standard edition of Photoscan. Many things can be done with 3-D models from printing them into physical models, creating orthographic plans to simple line drawings. It takes quite a bit of practice to make 3-D models from underwater photographs or video. Nothing beats practice, simply getting out there and recording sites and processing the data. There are online forums discussing different techniques and some detailed guides on how to accomplish some of the more complicated processes.

[bookmark: _Toc123998960]APPENDIX 2 – PHOTOGRAMMETRY SOFTWARE ACCESS GUIDANCE

To assist members to be able to process their images into 3D models, GIRT has purchased seven standard-edition stand-alone Agisoft Photoscan (Metashape) licenses. GIRT members can borrow a license (like a library book) simply by emailing GIRT member Alex Moss alex.moss@uclmail.net. Below are instructions for loading and unloading the software.

Please download the software from the official website (if you haven't installed it yet): http://www.agisoft.com/downloads/installer/

You can find installation instructions in Agisoft Photoscan User Manual available for download at:
http://www.agisoft.com/downloads/user-manuals/

Visit the Tutorials page http://www.agisoft.com/support/tutorials/ to learn some standard processing workflows.

Some useful tips on capturing scenarios can be found at http://www.agisoft.com/support/tips- tricks/

[bookmark: _Toc123998961]Installing and Activating Wreck Check/GIRT Photoscan software

Agisoft Photoscan is used for converting still images/video images into 3D reconstructions. It is a specialist surveying and visualisation tool and is quite expensive. The Professional version includes the capacity to make detailed linear measurements and calculate volumes. The Standard version is much cheaper and will fulfil most needs in Maritime Archaeology. 3D reconstructions produced in the Standard Version can then be imported into a Professional version to have distance and volumetric measurements made.
The software can be downloaded and installed for free but requires a purchased Activation Code to enable it to save any results.
[bookmark: _Toc123998962]Installing

Download the Agisoft Photoscan 1.4.5 “STANDARD EDITION” installer for your computer from….
https://www.agisoft.com/downloads/installer/

DO NOT install the Agisoft Metashape 1.5.0 installer. This is a major redevelopment and name change of Photoscan, just released in December 2018, but it has some major bugs in it. This will be fixed soon, but until then, use the tried and tested Agisoft Photoscan 1.4.5 “STANDARD EDITION”, which is still available for download further down the page.
Download and install Agisoft Photoscan 1.4.5 “STANDARD EDITION”. At the end of the installation process, the software will open a window asking you to choose to enter a licence code, continue with a trial version, or continue in “preview” mode, which will not allow you to save any results you create.
At this time, the software has already recorded the individual serial numbers of the CPU, motherboard and hard drive/s of your computer.

The 30-day trial option will allow you to save results, but you will not be able to get another 30 day trial on the same computer.
[bookmark: _Toc123998963]Activation

Use the Activation Code the Wreck Check/GIRT Administrator has provided to you. Enter this into the window and click “Activate”. If you have already moved past this installation stage before you received the code, then you can reopen this window by going to the menu bar at the top of the screen and choose HELP/ACTIVATE PRODUCT.
If you enter a code, and it is still active on another computer, an alert box will appear telling you that this code is already “locked” to another computer – even if that computer is not turned on, or not on a network. In this case, you will need to advise the Wreck Check/GIRT Administrator of this situation – someone who has previously had the Activation Code has not de-activated it from their computer as they were supposed to.
[bookmark: _Toc123998964]De-Activation

When the Wreck Check/GIRT Administrator requests that you de-activate the code on your computer, you need to go to the menu bar at the top of the screen and choose HELP/ACTIVATE PRODUCT.
A window will open telling you Photoscan is already activated, and next to that is a small button titled “Deactivate” you can click. It will then tell you your copy of Photoscan has been deactivated (assuming you were online at that time).
The code number you were using has now been “un-associated” with your computer, and you can advise the Wreck Check/GIRT administrator that the code can now be used by another computer.
You will still be able to use the software to import and align images, but you will not be able to save any of these results.
[bookmark: _Toc123998965]Additional Information

This is not related to the issue of Activation Codes, but it is important. When you install Agisoft you will also need to go into the menu bar at the top of the screen and choose Photoscan
/Preferences/GPU/ and tick the boxes under “GPU devices” to tell Photoscan to use the GPU (Graphics Processing Units)/video cards your computer has. For some reason, these are not selected by default. This will dramatically speed up the processing of the images.

[bookmark: _Toc123998966]APPENDIX 3 – EXPORTING A 3D MODEL FROM AGISOFT PHOTOSCAN / METASHAPE

Note: “Agisoft Photoscan” was renamed Agisoft Metashape” in 2019.

Andrew Hutchison, WreckCheck member – 08.05.2019.

[bookmark: _Toc123998967]Overview

Once you have processed a series of images into a 3D model in Photoscan, you then have the problem of getting it outside of Photoscan, so that it can be viewed on computers that do not have Agisoft.
This description does not include the process of importing and aligning images, or the process of creating point clouds and meshes, and then applying the photographic textures to them.
The basic workflow is described in the Agisoft manual, available from: https://www.agisoft.com/downloads/user-manuals/
This is the first draft of this document, so please do email me to let me know about problems, errors, suggestions.
mailto:andrew.h.hutchison@outlook.com

[bookmark: _Toc123998968]The Problem

Agisoft is a very specialist software originally intended for reconstructing landscapes from aerial photography for surveying purposes. It assumes a lot of pre-existing knowledge about computer processing, data types, etc. It can export models in a very wide range of specialist file formats suitable for use in other specialist applications/industries. Exporting a “demo” model that can be simply viewed on a normal computer without specialist software is not something that Agisoft does very easily.
[bookmark: _Toc123998969]Reducing the File Size

If you have made your model from a high-quality point cloud/mesh, and /or have chosen multiple textures, then when you export it, it may be very large in file size. This may be both a problem for emailing/uploading, and also may lag on the computer that it ends up on. So it is best to reduce the overall file size of the model.
The objective is to reduce the data size of both the mesh and the texture that make up the overall model, while retaining the “wow” factor. This will not provide a forensic level of detail in the mesh or texture, but it can be very powerful to show how well your model represents the object/scene you have captured.
You can reduce the model file size in the workflow order Mesh then Texture. Reducing the Texture to “1”
Start with the mesh and texture model that you are happy with. Go to Main Menu/

Workflow and then “Build Texture”. Make sure to have only 1 texture in the option box. The default setting is “1” but in case you or someone else has changed this to increase the quality of the model’s appearance, you need to reset it to “1” by remaking it.
So now you have your original mesh, and are confident you are looking at only 1 texture, which will reduce the overall file size.
Now copy this original Chunk by selecting it, right clicking, and choosing

“Duplicate” from the drop down menu.

[bookmark: _Toc123998970]Reducing the Mesh size

Select the newly created Chunk, and then go to the Main Menu, and choose

[bookmark: _Toc123998971]“Tools/Mesh/Decimate Mesh”.

It will prompt you to “decimate” the existing mesh to some value, that you have to enter. Choose something like 10% of the existing value.
When it has finished, 90% of the data in the mesh will have been removed… with some level of loss of actual detail. You will also notice that the texture that was with the mesh has also been lost. Now go to Main Menu/Workflow” and then “Build Texture” again.
You will notice that the time to create this texture is much less than the time to create the original texture … Because the time to create the mesh is a multiplier of the number of images
* the number of “faces"/vertices in the mesh. Less mesh = less texture time.

Once you have a texture on the new “90%”model, switch between the first chunk and the “90%” chunk to compare the way they look with the same texture on them. Probably, the much smaller mesh looks very much like the much bigger mesh. If it looks unacceptably squared/chunky, then you have reduced it too much.
If it looks okay, then save it out from Agisoft using one of the methods below, and see ifit works well. If it is slow to load or move, then you can go back and repeat the process… duplicate the original mesh, and then decimate it to only 50% of the original.
Then re-texture. And so on. At some point, you will get to a happy compromise of data size and appearance.
Of course, it is possible that you will find the first model works very well, in which case you could experiment with slowly increasing the quality detail. This would best be done first by increasing the number of textures, and then by increasing the size of the mesh.
[bookmark: _Toc123998972]Solution 1: Upload the model to the Sketchfab.com website

Agisoft has a menu option for uploading a model directly to the Sketchfab.com website. Go Main Menu/File/Upload Model.
Pros:

· You can just email or text a url to the person you want to see it, and they can look at it on any computer or smart phone without installing any software or logging in. It will just work.
· The model usually looks much better quality than in some of the other options.

Cons:

· You have to create a profile on sketchfab.com. However, it is free, and it takes only a couple of minutes to create the profile.
· You have to add in a passcode from Sketchfab each time you upload directly from Agisoft, but you can just follow the prompts that Agisoft provides to do this.
You can view the “Broken HMS Sirius” model made using this process here:

https://sketchfab.com/3d-models/broken-anchor-at-the-wreck-site-of-hms- siriusbf1b4d074143468c856cef35e115ff7d
[bookmark: _Toc123998973]Solution 2: Create a 3D.pdf

Agisoft can export an Adobe Portable Document (.pdf) format version of a 3D model.

Adobe Acrobat is free from the Adobe website, and is already pre-installed on most computers.
Pros:

· You can store your demo models on your own computer, which is good if you are somewhere you don’t have Internet access.
· You don’t have to use Sketchfab.com.

Cons:

· The person you are sending it to may have to download Adobe Acrobat

· The same model usually looks worse in Acrobat than it does on Sketchfab.com.

· Acrobat may interrupt the loading of the 3D model into Acrobat, and so you have to send the email with instructions on how to overcome these (provided below).The person you are sending to may give up trying.
Highlight your Chunk, and then choose “Main Menu/File/Export Model”.

Once the “save” box opens, you will need to select the correct file format from the pop down menu (.PDF). You can type your own text description into the box where it currently says “made with Agisoft”. Save it to wherever you want on your computer.
Then double click on the .pdf to open the model in Adobe Acrobat Reader. If this all works, you can just then send this as an email attachment.
“How to View Notes” to include in your email when you send the model.

You need to double click on the .zip archive.

Then double click on the .pdf, which will open Adobe Acrobat Reader on your computer, if you have it. If you don’t, then go to
 https://get.adobe.com/reader/ It’s free.
The 3D model might open up right away, and you will be able to click on it and rotate it around.

But it MAY just look like an empty white box, with a text description written in the bottom right hand corner.
If so, you will need to look for a yellowish alert message at the top, and click “allow this document…”
And then if you still don’t see anything, look for a small red icon, usually in the top left hand corner, and click on that, to tell Acrobat to “load the 3D
images”.

End of “How to View Notes”.

Please do advise me of mistakes/confusions in this first draft. mailto:andrew.h.hutchison@outlook.com
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Site Identification Sheet

Site: (Name of Wreck, Year of Sinking)

Statutory Database No:

Name of Statutory Database:

Number of surveys you have
conducted at this site:

Diver/s Name:

Date: Time of Survey:

Location (i.e. Latitude -18.6582, Longitude 146.489)

Position Format (Tick One)

Degrees and Decimal Minutes

Lat: hddd®mm.mmm’
Decimal Degrees
Long: hddd.ddddd®
Degrees, Minutes and Seconds
Circle one: Stern Midships Bow hddd® mm’ss.s”
Datum: Distance from nearest Land/Reef (nm):
[ ve= Oo-rom [ s-om
[ o O s O 0w
|:| Other: D 3—Snm
Current at Surface: North Tide at Survey Low
(speed in knots. Tick direction) North East (Tick one) Ebb
East Flood
South East High
south
(1 knot = 30.1 meters per
minute or 1.85 km per hour) South West
West
North West
Freshwater/Saltwater Yes - River Sediment Plume Yes
Influence Yes - Spring Visible in Water No
Yes —Run Off
Yes —Sea Water
No
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Sea State Degree | Height (m) Height (ft) Deseription
(Approx.) 0 no wave no wave Calm (Glassy)
(Tick One) 1 0-0.10 0.00-033 Calm (rippled)
2 0.10-0.50 0.33-164 Smooth
3 050-1.25 16-4.1 Slight
4 1.25-2.50 4.1-82 Moderate
5 2.50-4.00 82-13.1 Rough
Swell Height Degree | Description
(Approx.) 0 No swell
(Tick One) 1 Very Low (short or average and low wave)
2 Low (long and low wave)
3 Light (short and moderate wave)
4 Moderate (average and moderate wave)
5 Moderate rough (long and moderate wave)
Site Classification Structural | Organic Remains | Other Objects | Distribution
Remains
(Tick One) Class1 | Extensive | Many Many Coherent
Class2 | Elements | Some Many Scattered ordered
Class3 | Fragments | Some Many Scattered ordered
Class 4 - Few Some Scattered disordered
Class 5 - - Few Scattered disordered
Class 6

Reference Muckelroy, K., 1976, Maritime archaeology, New Studies in Archaeology, p.164. Table 5.2 The five main classes
‘of wreck site at present apparent in British waters. NB: Option 6 - is for sites that do not fit the pattern above. Add data in
the same manner outlined as you see fit.

Debris Zone Pattern

(Approx.) Pattern A

(Tick One) Pattern B
Pattern C
Other

Reference Warren, D.J., 2016, Acoustic Positioning and Site Formation on Deep-Water World War Il Shipwrecks' in Site
Formation Processes of Submerged Shipwrecks, ed. Matthew E. Kieth. University Press of Florida, 2016., pp- 235-248.
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Photo Condition Sheet

Diver/s Name:
Location; Date:
MudMap | Feature / Location Time | epthor| Direction 1o | Noor | observation of physical conditon, bioogical
Grid No. aiver (m) | photo taken | Photos | growth and sediment cover.
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Welcome to the GIRT survey reporting page. Please note that to input your survey data you will need to work
in FireFox, Chrome or Edge browsers/search engines. Please do not use Safari or Explorer at this time. When
you enter data it is very important that you press save on each page before pressing next. When submitting
lots of images and or the video transect data, rather than press save, | recommend pressing ‘save and
submit later’ and then wandering off for a cuppa tea and a chat if your upload speed s slow.

Once you start entering your survey data you can save the draft document and continue to work on
entering the data until you 'submit’ the document. Once the survey has been submitted, it will enter the
workflow and be assessed by a GIRT tutor. At this stage, the information will be reviewed, and the threat
assessment moderated in conjunction with you if required.

Once approved, the report will go live into production and be accessible to the public from the Adopted
Wreck page on the public portion of the website. The colour icon of your adopted wreck will change to
reflect your threat assessment and you will receive an email advising you that your report has been
accepted and is live. A PDF of your completed report is available when you view a survey report.

To commence submitting a survey click the button below:

ENTER YOUR SURVEY RESULTS
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Once approved, the report will go live into production and be accessible to the public from the Adopted
Wreck page on the public portion of the website. The colour icon of your adopted wreck will change to
reflect your threat assessment and you will receive an email advising you that your report has been
accepted and is live. A PDF of your completed report is available when you view a survey report.

To commence submitting a survey click the button below:

ENTER YOUR SURVEY RESULTS

Name of Wreck :

Gothenburg
Diver/s Name : Andy, Andy
Date: 2022-04-10
Uploaded at: 2022-04-22 03:09:51
INCOMPLETE
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of Submerged Shipwrecks, ed. Matthew E. Kieth. University Press of Florida, 2016., pp- 235-248.
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